
Section 4: Screen Readers 

SECTION 4 
SUPPORTING LITERACY WITH JAWS 

Introduction 

JAWS is an essential component of a complete literacy program for all Braille users.  
Some teachers may feel that a Windows computer is unnecessarily complex for a young 
student who is learning Braille.  We have found it effective to start with a refreshable 
Braille note taker like the Braille Note and then add JAWS and a Windows computer 
once the student is ready to proceed.  Many students successfully move into JAWS at 
the same time as they make the transition into the Intermediate grades.  The staff who 
are concerned about the complexity of JAWS are often quite relieved once they begin 
teaching JAWS.   While I understand their concern I feel that it may be based on a lack 
of accurate information.  Much of the often cited massive number of JAWS commands 
are in reality Windows from the keyboard commands.  If presented in a structured 
manner these commands, though numerous, are in fact quite manageable. 

If we wish to provide access to the full range of literacy building activities then JAWS will 
be required so that the student may independently access Windows, a full-featured word 
processor (MS Word), E-text (MS Word), the Internet (Internet Explorer), email 
(OutLook), presentation software (PowerPoint) and on-line encyclopedias (Grolier’s).  
Given the breadth of this topic each area will be discussed briefly with reference made to 
resources and supports rather then being described in detail. 

Regarding JAWS and Literacy, although there is a lot of information to cover, given the 
resources within JAWS, the online resources at www.setbc.org and other sites like 
Kathleen Beaver’s at Buffalo (http://atto.buffalo.edu/registered/Tutorials/jaws/index.php), 
when it is systematically introduced and taught, JAWS is an essential component of a 
complete literacy system for every Braille user. 

In this module, I will provide information on JAWS and a variety of Literacy activities. 
Implementation strategies and other ways to support the student will also be shared.   

Information and Instructions for Windows – Mouse Free, MS Word, and 
JAWS with EText, Internet, and Grolier’s Encyclopedia 

1. Windows From The Keyboard – Mouse Free  

Windows 98, ME, or XP is the system that makes your computer operate. It is called 
Windows because within the screen there are rectangular frames or windows that 
contain programs or documents. It is possible to have many windows showing on the 
screen at one time, and to work with them at the same time. (For blind students it is 
easiest to have only one window visible on the screen at a time – maximize current 
application window and document window.) Windows is a graphical operating system 
(GUI - graphical user interface). That means programs, menus and commands are 
represented by pictures and buttons on the screen. For the sighted user program 
pictures (icons) are double clicked on with the mouse to activate them. One click selects 
the icon and the second one chooses (or activates) it. Menus and commands (on-screen 
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buttons) are also typically graphical in that once clicked on, buttons depress or menus 
open.  

The Windows Operating System was developed so that all functions and commands 
could also be activated from the keyboard. For the purpose of understanding how a 
student who is blind will learn to use their computer, the emphasis in this presentation, 
will be on understanding Windows concepts, and navigation from the keyboard.  In 
Windows there are often many ways to achieve the same result.  It is essential that the 
way that is taught is the way that is most likely to support the student’s understanding of 
Windows, its programs and file management.  When you navigate using the keyboard 
you will notice that certain things (menu headings, icons etc.) will be highlighted 
(selected). This is referred to as the "focus". This term will be used throughout the 
presentation.  

The Windows operating system has certain conventions that are useful to understand. 
For the mouse user these conventions may not be readily evident.  

Windows contains two programs that allow the user to explore the hard drive and find 
out what programs and files it contains. The first is called Windows Explorer. It can 
show all of the folders and files on each drive in one window. The other program is My 
Computer. It shows only the folders and, when chosen, the files are displayed in a new 
window. It is highly recommended that students navigating from the keyboard become 
familiar with Windows Explorer, as the navigation within a single window is much easier. 
However, most mouse users will use My Computer because it is conveniently located on 
the desktop. 

Create New Folder  

A folder is a place where related files are stored. For students, folders are most often 
created to hold files that are related by subject. New folders can stand alone in the Tree 
View as a direct branch of the C: drive or they can be created within existing folders.  

Before making a new folder make sure that you know where you are making it. Folders 
can get lost when made inside of other folders if you are not careful. It is generally 
recommended not to have any more folders within folders than necessary, as finding 
them becomes increasingly difficult especially for the beginner.  

Place a Shortcut to a File or Folder on the Desktop 

It is sometimes useful to place a shortcut to a file, folder, or program on the desktop 
(although users who are blind often avoid the desktop due to the time it takes to navigate 
it).  

Placing a Shortcut on the Start Menu  

Another way to open a file or program is to place the shortcut on the Start Menu. To do 
this select the shortcut you have made on the desktop and drag it to the Start Menu 
button. It should appear after that at the top of the Start Menu. A program will only run if 
you have made the shortcut to the application’s executable file (.exe file). If it is a 
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shortcut to a file you have put on the Start Menu, both the application and the file will be 
opened.  

Creating a Hotkey  

You can create a hotkey so that a program will open using keyboard commands rather 
than the mouse. To do this you must first find the .exe file for the program. Then you can 
make a shortcut to it and place it on the desktop. You can then select the shortcut and 
use the keyboard command for a right mouse click (SHIFT+F10) and from the 
"properties" menu item create a hotkey command set to open the program.  

Also see Appendix A: Windows Navigation 

2. Microsoft Word from the Keyboard 

While most users are familiar with Microsoft Word using the mouse, pull-down menus 
and toolbars, it is completely accessible from the keyboard.  It can be accessed quite 
simply with a minimum of commands.  The ALT key and the Menus will allow the 
beginner to accomplish any writing task that the beginner may wish to do.  Gradually 
accelerator keys and toolbars can be introduced so as to reduce the learning demands. 

Accelerator Keys 

In addition to the keyboard commands (e.g. ALT + f; then n to open a new document) 
many word processing commands can be executed immediately by pressing CONTROL 
+ a designated letter. These "Accelerator keys" are noted in the pull down menus next to 
the menu item. Common ones are CONTROL + N to create a new document, 
CONTROL + O to open a document, CONTROL + S to save a document, and 
CONTROL + P to print a document (although there are others that will be noted later). It 
is important to note that the accelerator keys will only work when executed directly from 
the document. They will not work if the menu bar has the focus or if a menu is open.  

The Toolbar  

Word processing programs also have toolbars to execute common tasks. While there 
are many possible toolbars to choose from (see View menu/Toolbars submenu) the two 
most common ones are the Standard and the Formatting toolbars. Younger low vision 
students may find that the Standard Toolbar makes for easier access because it reduces 
the amount of memorization required (i.e. rather than remember CONTROL + P, they 
just click the toolbar icon). The JAWS user will most commonly prefer the "formatting 
toolbar".  

To get to a toolbar first change the focus to the Menu Bar by pressing the ALT key, then 
press CONTROL+TAB. This moves the focus to the toolbar. You can now use the Arrow 
keys to go across the toolbar.  Note that all toolbar actions are also available through the 
menus and many can be made using accelerator keys e.g. CONTROL+B to make 
selected text bold. To see these formatting and text attribute commands see the section 
on Windows Editing Commands that follows. Formatting changes will be in effect 
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immediately (center, justify). Editing and attribute commands (cut, paste, bold, italics 
etc.) will affect only text that has been selected first.  

Word Help can be accessed any time by pressing F1. It is organized in exactly the same 
manner and has the same features as Windows Help. The "index" tab is the most useful.  

Also see Appendix B: MS WORD 

3. JAWS 

JAWS (Job Access With Speech) is a screen review program produced by Freedom 
Scientific (www.freedomscientific.com) that recognizes all text based information on the 
computer screen and converts it to spoken words and/or refreshable Braille.  JAWS is 
designed to work in a Windows environment. It is compatible with almost all Windows 
applications.  Commands that make JAWS speak fall into two categories:  

1. JAWS will speak all Windows keyboard commands and all MS Word keystrokes 
and commands  

2. JAWS has its own command set for speaking text and to enable blind users to 
move to the parts of the screen and other information that is present visually, 
(e.g. Window title).  This allows the Braille user to use Windows without using a 
mouse.  JAWS also has its own command set to customize the speech itself (e.g. 
pitch, rate)  

JAWS has multiple cursors, however, the two that are introduced to beginners are the 
PC cursor, which provides speech for all keyboard commands, and the JAWS cursor 
which is similar to the mouse pointer in that it can travel all over the screen (using the 
Arrow keys) and speaks that location. If you wish to experiment you can switch between 
the two by pressing the Numpad + key for the PC cursor and the Numpad + - key for the 
JAWS cursor)  

Some important Program commands that are specific to JAWS include:  

• Interrupt Speech -- Control key  
• Say Window Title -- Insert + t  
• Say Top Line of Window -- Insert + end key  
• Say Bottom Line of Window -- Insert + Page Down  
• Screen Sensitive Help -- Insert + F1  
 
Some important Dialogue Box commands that are specific to JAWS include:  

• Say Default Button -- Insert + e  
• Read Box in Tab Order -- Insert + b  
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JAWS has many helpful features. Some of these include:  

• Various levels of verbosity (detail) which give varying degrees of description of a 
window, control or field, can be adjusted depending on the user’s needs (defaults to 
verbosity: most)  

• A virtual viewer which gives explanations in a separate window that can be read and 
reviewed by line.  

• In a word processor all text attributes will be described by pressing Insert + f  
• Note that within the JAWS program you do have access to context sensitive JAWS 

Help where you will find an extensive list of commands Insert + F1  
• There is extensive on line documentation for the instructor within JAWS. Go to the 

JAWS Menu; select Help; then JAWS Help Topics; then go to the Contents page and 
read New Users Start Here and Keystrokes.  It is reasonable to expect the student to 
start looking for answers themselves within this help documentation. 

4. E-text 

Introduction 

Students who are blind require access to alternate format, digital, electronic text 
materials accessible through speech, refreshable Braille and/or magnification. E-text, or 
electronic text, is a computer readable electronic file that duplicates a physical, print text 
such as a textbook. E-text is strictly text. There are many types of etext including ASCII 
or Text (.txt), Rich Text Format (.rtf), Word Perfect (.wpd) and Word (.doc). Most of the 
e-text produced for PRCVI comes in ASCII, Word Perfect and Word. Graphic information 
(pictures, charts and graphics) found in the print textbook should be made available to 
the student. PRCVI provides an accompanying tactile diagram booklet(s) for many titles. 
If another supplier provides e-text without tactile diagrams and if it is determined that 
these graphics are necessary for the students’ understanding, then they should be made 
available.  Students who are proficient with computer technology can create their own e-
text using a scanner and appropriate OCR software (e.g. Arkenstone Open Book or 
Kurzweil)  

Prerequisite to using e-text  

Student needs to have basic computer and word processing skills. They also require 
basic operating skills for their screen reader (e.g. JAWS) and/or their screen 
magnification program (e.g. Zoomtext Level 2 or Magic). Braille note takers (e.g. Braille 
‘n Speak, Braille Lite or Braille Note) may also be used to access e-text although they 
are beyond the scope of this presentation.  

Necessary Team Support  

• Positive attitude towards the use of e-text 
• Staff competency in using hardware and software 
• Basic troubleshooting skills 
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Classroom Implementation Strategies 

• Start young - share simple stories, for example, classmate stories can be made 
available on disk (remember to include descriptions of pictures and graphics and/or 
construct a supplementary tactile diagram booklet) 

• Read beginning "chapter" books in e-text 
• Provide a Braille or Large Print hard copy to complement the e-text when the student 

is learning to use e-text 
• Encourage the experienced user to choose the medium that best suits the specific 

task. 
• Keep the "original" safe. E-text should be saved on the student’s hard drive (C:\) in 

the subject folder 
• E-text is often provided in many individual files. It may be necessary to provide 

instruction on how to merge and append these files in order to build the book (see 
section Using E-text Textbook with MS Word 2000) 

• Provide instruction concerning format issues with respect to Table of Content, Page 
Number Location, and Graphic Descriptions 

• Teach the use the Find feature to locate page, keywords, and markers 
• Teach the use of Copy and Paste features to input information into a new document 

• Provide instruction concerning copyright issues 

User Profile Checklist 

In order to successfully use e-text the following skills are necessary:  

1. View and open files from a floppy disk. 

2. Navigate the Treeview and Listview in Windows Explorer. 

3. Create new folders in Windows Explorer. 

4. Rename files in Windows Explorer.  

5. Copy and paste documents within Windows Explorer.  

6. Understand extensions (.doc .txt .wpd .rtf).  

7. Open, read and save Word and/or Word Perfect documents.  

8. Open, read and save Notepad and WordPad documents.  

9. Copy and paste (multiple) e-text file(s) contiguously from the floppy disk into a 
single file (merge or append).  See section titled Using Insert File to assemble 
ebook.  

10. Use the Find Text command to navigate the textbook file.  

11. Move (within the application) between the textbook file and files made for notes 
and assignments.  

12. Move between application programs.  
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Information and Instructions on JAWS and E-Text 

Inserting a personal marker to save your place  

• Insert a marker to find your place easily the next time you open the file by typing in 
a code word (nonsense word e.g. lookingfor) at the spot where you would like to 
open the file next time. 

• Save file. (Ctrl S) 
• When you open the file the next time use the "find" command (Control+F) on the 

code word and the file will open at that place. Do not use common words as they 
will be found in other places in the file. 

• This can also be done with the Bookmark feature in Word however the bookmarks 
must be inserted prior to use. Inserting your own nonsense word seems quicker 
and reinforces the Find command which is a key to efficient reading of an ebook. 

Using an E-text Textbook with MS Word 2000 and JAWS  

Some of the e-text titles come in sections or in chapters.  Many students will be more 
efficient if they have a copy of the complete e-text book. There are 2 ways that you can 
assemble the files into an ebook. The first and preferred way is to use MS Word’s 
Insert File feature found in the Insert Menu.  The second and more time consuming 
way is to copy and paste the files into a new file until you have assembled the book. 

Using Insert File to assemble ebook 

• Put the E-text disk in A:Drive. 
• Go to Start Menu (Ctrl + Esc), select Programs (P), select Windows Explorer and 

press enter. 
• Select C:\ and open the File menu. Select "New" and choose "Folder". Name the 

folder according to the subject. 
• Make a new folder within the subject folder and name it "textbook". 
• In Windows Explorer select 3 1/2" Floppy (A:) by using up arrow and press enter. 

All the files on the A drive will be shown. Select all of the files on the disk (Ctrl + A). 
Copy them into the "textbook" folder. 

• Open a new document in Word. 
• Save new document as "file name_assembled" 
• Choose Insert File from the Insert Menu.  In the Insert File dialogue box select the 

first chapter file and then hit Enter. 
• Repeat Insert File until you have inserted each file in the book.  Make sure that 

each file is inserted in order and don’t move the cursor until you have assembled 
the complete ebook. Note that the cursor defaults to the end of the inserted file, if 
you move around in the file and then use Insert File that file will be inserted at the 
cursors prior location. 

• Save the document (which now contains the collated book) with the book title into 
the subject folder. 

• Delete the "textbook" folder that had all of the individual sections or chapters 
 
Note:  you may rename assembled book as you see fit. 
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5. JAWS and the Internet 

Introduction 

Why use the Internet?  
A great deal of useful information is available online to students who are blind.  This 
includes information that is not otherwise available in any other medium.  Examples of 
this information are:  

• Newspapers and magazines 
• E-text books 
• Source documents and reference material needed for reports and assignments.  

JAWS makes the Internet quite accessible (however, it has some of its own key 
commands to do so). Once a web page is loaded JAWS automatically describes the 
page re: the existence of frames and the number of links. The virtual cursor then takes 
over and reads the entire page identifying links, edit field, radio buttons, etc. JAWS also 
informs the user when frames are being entered and exited. The speech can be halted 
at any time and the user can direct JAWS to read by line using the arrow keys. The user 
can move from one link to the next by link by pressing the Tab key.  If there is one or 
more edit fields on the page JAWS has the ability to go into Forms Mode and move 
between them. A complete web page can also be copied and pasted into a Word 
document if the user so desires. Students should be encouraged to use the Internet. It 
will be desirable to direct students to sites that are of interest to them starting with easily 
accessible sites. As the student becomes more proficient with the Internet and JAWS 
then they may be directed to more complicated web sites. 

Pre-requisite skills 

• Familiarity with basic computer operation 
• Familiarity with JAWS including multiple cursors and when to use them 
• Familiarity with Internet Explorer 5.5 
• Familiarity with a word processor 

Equipment Needed 

• Pentium computer with modem or network card installed and configured 
• JAWS current version 
• Microsoft Internet Explorer ver. 5.5 or 6.0 (Note JAWS is designed to work 

seamlessly with the Internet using Microsoft Internet Explorer ver. 5.5 or 6.0) 
• Access to the Internet through an Internet Service Provider (ISP) or network 

Internet Concepts 

• An understanding of the nature of web pages, which may include graphics, multiple 
panes (called frames), pop-ups in new browser windows, link(s), 

• The Uniform Resource Locator (URL) which is the specific web address and must be 
entered exactly in order to open the web page. 
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• In order to make Internet Explorer accessible there are some JAWS concepts and 
keystrokes that must be learned and understood. An example of this is the Virtual 
Cursor (available in the more recent versions of JAWS). 

Information and Instructions for JAWS and the Internet 

• Information is found on the Internet using "Search Engines". 
• The choice of search engines is important. Desirable features include: accessibility 

with JAWS or large print magnification program, few graphics; options to search "any 
word", "all words", or "as a phrase". 

• Several useful search engines are www.google and www.yahoo.ca; most students 
find Google quite accessible. 

• Meta-search engines search other search engines to find more sites relevant to the 
search query. 

• Stand alone programs such as Copernic (www.copernic.com) search many other 
search engines and provide a list of query results in the form of links. Choosing a link 
opens Internet Explorer and goes to that website. All search results are saved within 
the program for future reference.  If the JAWS scripts for Copernic are loaded then 
Copernic is very accessible to JAWS’s users.* 

• Relevant web material can be copied from Internet Explorer (Edit menu) into a word 
processor and saved for future reference. 

• Many people are concerned about the appropriateness of some of the information on 
the World Wide Web (Internet).  Using Grolier Encyclopedia and its protected 
Internet search capabilities is sometimes an acceptable way to access the 
information on the web while ensuring that the student is screened from 
inappropriate information. 

Advanced Internet Navigation with JAWS  

(Note the reading of these files is not required for this presentation however they are 
useful resources.)  
Explanations of JAWS commands related to Internet Explorer can be found within the 
JAWS Help files. To find these commands open: JAWS Help; then open the "Contents" 
page; open "Popular Applications with JAWS"; open Internet; open Internet Explorer; 
open JAWS Specific Keystrokes.  If additional detail is required open the "detailed 
description of keystrokes" link.  
It is beyond the scope of this presentation to describe advanced Internet navigation with 
JAWS.  Useful resources to support teachers and students may be found in the 
previously cited JAWS Help Files for Internet Explorer and the tutorials prepared by 
Kathleen Beaver at the following URL:  
 
http://atto.buffalo.edu/registered/Tutorials/jaws/index.php  

Also see Appendix C: JAWS and Internet Explorer 
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6. Grolier CD-ROM Encyclopedia 

Description of Student needs 

Low-vision and blind students need an independent method of accessing resource 
material for research projects. With the availability of appropriate CD- ROM multi-media 
resources like the Grolier 1999 or 2000 Multimedia Encyclopedias, coupled with access 
to the Internet, computer-centered "information retrieval" promises to provide 
unencumbered access for these students.  
A large print user may use many different CD-ROM encyclopedias. The screen review or 
JAWS user is limited to Grolier 1999 or 2000 since these are the two versions that are 
accessible to JAWS currently.  

Prerequisite skills to use the encyclopedia independently 

• Good JAWS skills for navigation within Win ME/98/XP 
• Ability to switch between open applications (JAWS, Word & Grolier) 
• Effective word-processing with JAWS skills for navigating, selecting, copying and 

pasting 
• Familiarity with multiple pane pages. (Windows Explorer with its List and Tree views 

is an example of page with multiple panes.) 
• Understanding of multiple cursors and how/when to use them 
• If the student is going to use the Internet search features of Groliers, then some 

limited familiarity with JAWS access to the Internet 

Equipment Needed  

• Windows ME, 98 or XP based computer 
• Word-processing program, MS Word for Windows is the most accessible to JAWS 
• JAWS (current version) screen review software 
• Internet Explorer 5.5 or 6.0 
• Grolier 1999 or 2000 Multimedia CD-ROM Encyclopedias 
• If the student is going to use the Internet search features of Groliers then Internet 

access must be in place (LAN or Modem) 

Team support needed to ensure technology would be implemented successfully 

• Good JAWS skills with respect to complex (multi-media) screen presentations. 
• Introduce JAWS & Windows concepts 
• Set up Grolier’s before student tries to use software. Out of the box, it is not fully 

accessible to the JAWS user 
• If the student is going to use the Internet search features of Groliers then setup 

Internet Explorer as the web browser for Grolier 

Classroom implementation strategies 

• Show student how to access the extensive help documentation contained within 
JAWS. (Open JAWS; Open Help Topics; Open Contents Page; Open Popular 
Applications with JAWS book; Open Reference & Educational book; Open JAWS 
Specific Keystrokes. For an explanation of each keystroke & some related 
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information Open JAWS Specific Keystrokes and then Open link Detailed Description 
of Keystrokes.) 

• Practice - Find text and subsequent Copy from Grolier’s & Paste into Word using 
JAWS.  (If not already proficient) 

• Coach user in keeping "keyboard command sets" differentiated as they switch 
between programs. (JAWS vs Windows vs Groliers) 

• Access sound clips and recordings from within Groliers 
• Access Internet with protected access provided by Groliers 

Common barriers or challenges that might occur 

• Some features of Groliers are completely graphic (not text) and as such are not 
accessible to JAWS 
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Appendices 

Appendix A:  Windows Navigation 

Windows Cursor Navigation  

Windows uses standard keystrokes within a document for moving the cursor (regardless 
of the word processor used). Windows cursor navigation commands are:  

• To move the cursor by character use the Left and Right Arrow keys 
• To move by word use CONTROL + Left or Right Arrow keys 
• To read by line use the Up and Down Arrow keys 
• To move the cursor to the start of the line press the Home key 
• To move the cursor to the end of the line press the End key 
• To move the cursor to the start of the next paragraph press CONTROL + DOWN 

ARROW 
• To move the cursor to the start of the previous paragraph press CONTROL + UP 

ARROW 
• To move the cursor to the start of the document press CONTROL + Home 
• To move the cursor to the end of the document press CONTROL + End 
• To move the cursor to the start of the next or previous physical print page press 

CONTROL + Page Down or CONTROL + Page Up 

Windows Editing Commands 

The following commands will make changes to text that is written:  

Selecting Text 

Windows has standard keystrokes for selecting (highlighting) text. Text must be 
selected before it or its attributes (font, size, bold, italics etc) can be changed. Text 
that is selected (highlighted) is very fragile. It will be replaced by any letter that is 
typed and will disappear entirely if Enter or the Spacebar are pressed. If you make 
any mistake and your text disappears, you can Undo it by pressing CONTROL + Z. 
Each time you press CONTROL + Z the screen will display the text prior to that 
keystroke, so if a mistake is made but not realized for a few keystrokes, the user can 
go back to the mistaken keystroke by pressing successive CONTROL + Z 
commands.  
The Windows commands for selecting text are:  

• Select Letter  Shift + Right or Left Arrow 
• Select Word  Shift + CONTROL + Right or Left Arrow 
• Select Line  -  With cursor in home position press Shift + Down Arrow 
• Select Paragraph  With Cursor in home position press Shift + CONTROL + 

Down Arrow 
• Select All Text in the document  CONTROL + A 
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Editing Text 

Windows has standard editing commands (common to all word processors). They 
are:  

• CONTROL + Z - to undo the last text entered or command given. Repeated 
Undo commands allow the user to return to previously entered text. 

• CONTROL + Y - to redo the last text entered or command given. 
• CONTROL + X - to remove or cut selected text from the document and place it 

on the clipboard. The clipboard is a temporary holding area on the computer 
where text can be stored. 

• CONTROL + C - to copy selected text to the clipboard. 
• CONTROL + V - to paste text back into your document. Text that has been 

copied or cut to the clipboard will be pasted at the new cursor position regardless 
of the application that is open i.e. text cut or copied from Word can be pasted into 
another word processor or email document. 

Note that text must be selected before the above commands will work (except the 
Undo command)  

Changing Text Attributes 

Windows has standard attribute commands for changing the appearance of text. 
These commands are common to all word processors. They are:  

• CONTROL + B - to make selected text bold (pressed again will the remove bold 
style) 

• CONTROL + I - to make selected text in italics (pressed again will the remove 
italics style) 

• CONTROL + U - to make selected text underlined (pressed again will the 
remove the underline) 

• CONTROL + SPACEBAR - to remove all styles and make selected text plain 

Formatting Commands 

The following formatting commands will affect the whole line or paragraph that 
contains the cursor. There is no need to select text for the following line commands 
to work.  

• CONTROL + E - to center text 
• CONTROL + L - to left justify text 
• CONTROL + R - to right justify text 
• CONTROL + J - to block (right and left) justify text 

 

Dialogue Boxes 

A dialogue box is an interactive window that opens over top of your document to 
request information from you. It does not have a menu bar, but rather, has a series of 
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different types of buttons and controls. When faced with a dialogue box you must 
respond to it or Windows won’t let you proceed. If you want to close the dialogue box 
without choosing any options, press Escape. This will return the user to the text edit 
field.  

You will encounter dialogue boxes when you choose an item from a pull-down menu 
that ends in an ellipsis (...).  The most common ones are "print", "find", "save" (only 
the first time) and "save as".  
When a dialogue box opens it becomes the active window. This window presents 
you with options from which a choice must be made. To move through the options in 
a dialogue box press the TAB key.  

While there are many different dialogue boxes, they look similar. There are 8 
different Controls that provide for all possible options in any dialogue box. These 
Controls make changes and execute the commands in the dialogue box. Not all 
dialogue boxes will contain all of the 8 Controls. All dialogue boxes will have a 
default option (usually the OK Button). Windows will move the focus to the default 
option (e.g. OK) as soon as the dialogue box opens. A default is the option the 
computer thinks you are most likely to choose so it is already selected. If the 
dialogue box requires that you type in information before you continue, this will be 
the default option. This area where the computer is expecting you to enter text is 
called an edit field. The "Find" Dialogue Box is an example of this.  

The Controls 

The 8 Controls that allow you to choose options and execute commands in a 
Dialogue Box are: Button, Check Box, Radio Button, Edit Field, List Box, Combo 
Box, Slider and Spin Box. To move from Control to Control press the Tab key. Use 
Shift+Tab to go back to the previous Control.  
Within a dialogue box, each Control is different and has its own Windows command 
to manipulate it. 
 
Multi Page Dialogue Boxes (tabbed pages) 
Some Dialogue Boxes are divided into related pages where each page is a separate 
Dialogue Box (called Multi-Page Dialogue Boxes). Page Setup in the File menu is a 
good example of a Multi-Page Dialogue Box. Press CONTROL + TAB to switch 
between pages in a Multi Page Dialogue box in succession, regardless of where the 
focus is within the page. Pages cycle continuously as CONTROL + TAB is pressed. 
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Appendix B: MS Word 

There are many settings within Word that will make it much easier and more efficient for 
users who are blind. To keep Word as simple and efficient as possible, the following is 
recommended. Note that newer versions of JAWS may not require all of these changes 
to the configuration. The following 8 items are for your information. You do not have to 
try them as part of this Presentation.  However, you may find them useful especially for 
some students and for older copies of JAWS and MS Word.  

1. Turn off the Office Assistant. To do this, choose the Help icon from the Standard 
toolbar. Choose Options and uncheck everything. Close the Office Assistant. 
(Not required for JAWS 4.02) 

 
2. Set the screen view to normal. To do this open the View menu, select "Normal", 

and press Enter.  
 
3. Remove the ruler. To do this, open the View menu and select "Ruler". Uncheck it 

by pressing Enter.  
 
4. Remove all toolbars except the formatting toolbar. To do this, open the View 

menu. Go to the Toolbars submenu and uncheck all other toolbars using the 
Enter key.  

 
5. Remove all automatic formatting options for automatic numbers and bullets. To 

do this, open the Tools Menu and choose Auto Correct. A Multi-Page Dialogue 
Box opens. Use CONTROL+TAB to open the "AutoFormat as you type" page. 
Arrow through the page and uncheck "automatic bulleted lists" and "automatic 
numbered lists" using the Spacebar. Use CONTROL+TAB to open the 
"AutoFormat" page. Arrow through the page and uncheck "automatic bulleted 
lists". Tab to the OK button and press Enter to close the dialogue box. 

  
6. Remove automatic spelling and grammar indicators. To do this, open the Tools 

menu and then open Options. A Multi-Page Dialogue Box opens. Use 
CONTROL+TAB to open the "Spelling and Grammar" page. Arrow through the 
page and uncheck "check spelling as you type" and "check grammar as you 
type". Tab to the OK button and press Enter to close the dialogue box. (Not 
required for JAWS 4.02) 

 
7. Remove the vertical and horizontal scrollbars. To do this, open the Tools menu 

and then open Options. In the Multi-Page Dialogue Box that opens go to the 
View page by pressing CONTROL+TAB. Arrow through the page and uncheck 
"horizontal scroll bar" and "vertical scroll bar". Tab to the OK button and press 
ENTER to close the dialogue box.  

8. Set File Menu to display up to the 9 most recent documents. The default number 
is 3. To increase it open the Tools menu. Open the Options Multi-Page Dialogue 
box. Use CONTROL+TAB to open the "General" page and arrow to the "recently 
used file list". Press Tab and you will go to the Spin Box where you may type in a 
new number, up to 9. Tab to the OK button and press Enter to close the dialogue 
box. Word will now display that number of recently used documents at the end of 
the File menu. 
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Appendix C: JAWS & Internet Explorer 

• Press ALT + d to move the focus to the address bar and type www.google.com and 
press Enter. Listen to how the Virtual Cursor reads text, and identifies links and radio 
buttons. Note that you can read the address bar without moving the focus to it by 
pressing Insert + a.  

• Press Insert + F7 to see the JAWS Links dialogue box. Note the options that the user 
is presented with. Press Escape to exit this dialogue box.  

• Press Control + Insert + Home to move the JAWS focus to the search edit field.  
• Press Enter to turn on Forms Mode so that you can type in this edit field (Note that 

although the Windows focus is on the edit field on this web page, not all web pages 
default to the edit field so this is JAWS way of getting the focus on the edit field.  

 

A “Related Materials” section is included in this resource book.  Please refer to the 
Related Materials section for a list of narrated screen demonstrations that have been 
developed for each content section. All narrated screen demonstration files are included 
on your Accessing Literacy cd, also included with this resource book. 
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